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This Standard Operating Procedure explains the procedures that all observers should 
follow to set up and use the Garmin V GPS unit with differential correction beacon 
receiver to collect data and navigate to survey locations. 
 
Key Concept: PDOP (proportional dilution of precision), a measure of GPS accuracy.  
Download almanacs for the day on which fieldwork will be conducted from a base 
station near the park you will be visiting.  Then use Trimble’s free planning software to 
identify times of high PDOP.  GPS data should be collected when the PDOP is low, 
ideally below 6.  High PDOP typically reflects a combination of poor satellite 
geometry and unfavorable atmospheric conditions. 
 

 
 

Using the Garmin V GPS Unit 
 
References 
 
1. Garmin V Personal Navigator User’s Manual and Reference Guide 
 
2. Garmin MapSource User’s Manual and Reference Guide 
 
3. MBX-3S Differential Beacon Receiver Manual 
 
4. Backpack Assembly Instructions for Garmin V System  (3-D Marketing, LLC):  

Appendix A 
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I.  SCHEDULING FIELD DAYS 
 
In order for your GPS unit to collect accurate geographic locations, it is preferable to 
schedule field data collection for times when there are at least 4 satellites overhead and 
the estimated PDOP (the measurement of relative accuracy) will be less than 6.  In 
order to facilitate data collection mission planning, almanac files (sets of data that are 
used to predict satellite orbits over approximately a one month period) are available 
from GPS base stations throughout the world.  The almanac files can then be read using 
free planning software available from Trimble . 
 
1.) Downloading the Current Almanac and Planning Software 
 

a) Download a free copy of Trimble Planning Software  from 
http://www.trimble.com/planningsoftware.html, and follow the setup 
instructions. 

 
b) Identify a GPS base station nearby to the area where data collection will take 

place.  In southern New England, the University of Rhode Island hosts a station 
at http://www.edc.uri.edu/gps/.  Stations for other areas can be found at 
http://www.fs.fed.us/database/gps/clickmap/cbsmap.htm.  

 
c) Make a note of the base station’s latitude, longitude, and elevation. 

 
d) Download the almanac that covers the time and date when data collection will 

take place. 
 
2.) Accessing the Almanac 
 

a) Open the Trimble Planning Software .  Under File -> Station, enter your base 
station information and click OK. 

 
b) To import the almanac, select Almanac -> Import -> .SSF (or other appropriate 

file format). 
 

c) For a graph of satellite availability throughout the day, choose Graphs -> 
Number of Satellites.  GPS readings may be rejected when there are less than 4 
satellites available. 

 
d) For a graph of PDOP estimates throughout the day, choose Graphs -> DOP -> 

Positional. A PDOP above 6 is generally considered too high.   
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II.  PRE-TRIP PLANNING  
 
1.) Plan your route.  Planning your route can maximize your time by allowing you 

to collect information on several features on the same trip.  In addition, the 
topography of the area where you are collecting data may require changes in the 
Garmin V’s elevation configuration.   

 
2.) Check battery levels.  At least 8 hours before anticipated use, check to ensure 

that batteries have been fully charged.  This can be done by observing the 
battery icon on the Main Menu screen of the Garmin V (accessed by pressing 
the Menu button twice). 

 
[Note:  using 3-D’s AC/DC Adapter (output 12VDC @ 500mA), it will require 8 
full hours to completely recharge a drained battery. It will require 4 hours to 
completely recharge a 50% drained battery and so on.] 

 
3.) Suggested field materials and equipment. 

1. notebook and pencil 
2. GPS unit 
3. GPS field guide (this document) 
4. extra batteries 
5. watch 
6. water 
7. compass 
8. radio or cell phone 
9. bug repellent 
10. field guides as needed 

 
 
III.   SYSTEM ASSEMBLY 
 
For complete instructions on assembling the NPS backpack unit with Garmin V 
receiver and differential correction beacon, see APPENDIX A. 
 
Garmin V / Beacon Unit Setup 
 
1. Each GPS unit is stored in its own NPS backpack.  Even though parts are 

interchangeable, the units should be stored as complete sets.  
 
2. At least 8 hours before anticipated use, check to ensure that batteries have been 

fully charged.  Using 3-D’s AC/DC Adapter (output 12VDC @ 500mA), it will 
require 8 full hours to completely recharge a drained battery. It will require 4 hours 
to completely recharge a 50% drained battery and so on. 

 
3. Place one of the small, black, Velcro™ battery holders (unfolded) on a flat surface 

with the center felt surface facing down and the small tail strap pointing towards 
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you. Lay the external battery (Multiplier label face down and CLP plug on the top 
left) in the center of the holder, flush with the bottom. Fold small tail strap up over 
the battery so that it now points away from you. Fold the right-hand side of the 
pocket over and then the left-hand side so that all attach snugly together, and then 
attach this inside the backpack, near the bottom. 

 
4. The MBX-3S beacon receiver has no ON/OFF switch. It is turned “ON” or “OFF” 

by connecting or disconnecting it from the power supply. At this time, turn the 
MBX-3S “ON” by plugging the black, male, cigarette lighter adapter plug on the 
RED Quadcom cable, into the female cigarette lighter socket from the battery. The 
MBX-3S receiver display will come on and begin its startup sequence. Once the 
MBX-3S is powered, it will begin searching for the strongest differential signal 
available. To maximize DGPS positional accuracy and repeatability, it is 
recommended that you manually tune the beacon receiver to the closest differential 
transmitting station, instead of allowing it to run in automatic search mode. This is 
best-done using the Garmin GPS receiver. 

 
5. Turn on the Garmin GPS by holding the Power key down for 2 seconds.  Enter out 

of warnings / intros.  Press the MENU key twice, scroll down to the SETUP 
selection and press ENTER.  Scroll to the last sub-menu, which is the INTERFACE 
menu.  This is where you set up the Garmin GPS for differential operation. 

 
6. Scroll down to the Format field and press “ENTER.”  Scroll down to “RTCM 

In/NMEA Out”, and press “ENTER” Once this selection is made, the Baud Rate, 
Beacon, Freq., and Bit Rate fields will appear.  See APPENDIX B for help in 
choosing settings from an appropriate differential correction beacon. This 
information can also be found  by accessing the United States Coast Guard web site 
at: www.navcen.uscg.gov/ADO/DgpsSelectStatus.asp or accessing the CSI 
Wireless web site at: www.csiwireless.ca/support/pdfs/radiolistings.pdf.  

 
[If you do not have web access and know the name of the closest beacon station, but 
do not know the frequency, you can use the Beacon Table in the MBX-3S. On the 
MBX-3S receiver you have three functional buttons, an UP arrow, a DOWN arrow 
and an ENTER button. In order to select an option on the receiver, the desired 
selection must be on the top line of the two line display, and then the ENTER button 
must be pressed to select the option. If an undesired selection is made, then scroll 
up or down to the “BACK” selection, and press “ENTER” This will return you to 
the previous menu level. Once the MBX-3S has finished its start-up sequence, you 
will see “Stn XXX.0 BX00” Press ENTER. Scroll down so that "Select Beacon" is 
on the top line of the display. Press ENTER and scroll down until "North America" 
is on the top line. Press ENTER. Scroll down until "U.S.A." is on the top line. Press 
ENTER. Scroll up or down until you find the name of the beacon that is closest to 
your location and press ENTER to select it. The receiver will say "Sending 
Command...." and will try to lock on to the station. The correct frequency and bit 
rate will be displayed for a few seconds while it tries to tune. Make note of these 
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numbers and then re-tune to that frequency using the Garmin GPS as per Step 6 
above.] 

 
7. The word “Receiving“ will be displayed in the “Status” field. Once lock is achieved 

on the MBX-3S, the SNR value will appear in the “SNR” field. At the same time 
the word “Differential” will also appear on the satellite page to confirm that you 
have a “Differential GPS” position. Push the QUIT button and return to the set of 
main pages. Press the PAGE button until you see the signal strength bar and sky 
view page. The signal strength bars should have a small “D” in the bottom of them 
if the GPS receiver is receiving a valid differential signal. Your position will also be 
displayed as a “3D Differential” position.  

 
Note: The Signal to Noise Ratio (SNR) value must be higher than 6 for the receiver 
to lock. When it locks on to a station, the lock symbol in the top right corner of the 
display of the MBX-3S will close. If it does not immediately lock on to the station, 
there can be several reasons; if you are inside, the type of building material can 
prevent lock, if you are outside, power lines or other sources of RF interference can 
be present. If you are in a vehicle, try to locate the MGL-3 antenna away from the 
engine. Moving the antenna just a few inches can make a difference. If after being 
in differential mode, the MBX-3S loses lock status, the Garmin GPS will continue 
to operate in “Differential” mode for 30 seconds, after which time an error message 
will appear, letting the user know that differential is no longer available. 

 
8. Enable WAAS—When the dGPS beacon signal becomes unavailable when 

navigating in the field, WAAS (Wide Area Augmentation System) capability 
improves the positional accuracy of the GPS unit by searching for a WAAS satellite 
near your location and receiving differential correction data.  When WAAS is 
enabled, you will see WAAS satellite numbers of 33 or above displayed on the 
Satellite Status Page, and a “D” will appear above the signal bars for all satellites 
from which differential data has been received. 
 
At the Setup page off of the Main Menu, scroll to the System tab and highlight the 
WAAS field.  Press the Enter key and choose ‘Enabled.’ 

 
 
 

IV.  FILE UPLOAD FROM PC TO GPS UNIT USING MAPSOURCE  
 
Waypoints, detailed street maps, and other spatial data can be uploaded to the Garmin 
V to aid in navigation using the accompanying MapSource  software.    
 
1.) Connecting the GPS Unit to the Computer:   
 

a.) Connect the gray Data/Power Cable (Garmin 4-pin connector) from the backpack 
setup to the GPS Unit. 
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b.) Connect the dark blue PC interface cable (9-pin connector) from the backpack 
to a Serial Communications Port on the computer.    

 
c.) Turn the GPS unit on by pressing the power button for two seconds.  Press the 

Menu button twice to access the Main Menu.  Select the Setup page and scroll 
to the Interface tab.  Make sure that the Serial Data Format is set to ‘Garmin.’  

 
d.) In MapSource, select Preferences from the Edit Menu and click the Transfer 

tab.  Click the Auto Detect button and make sure the software has detected the 
correct port and Garmin unit. 

 
2.)   Uploading Data to the GPS Unit:  
 

a.) In MapSource, select ‘Save to Device’ from the File menu. 
 
b.) Choose the formats of the files to upload, and click Save.  

 
 

V. DATA CAPTURE 
 
1.) Saving Waypoint Locations— The Garmin V can hold up to 500 Waypoints. 
 

a) Press and hold the Enter key.  The ‘Mark Waypoint’ page appears, with a 
default 3-digit name for the point.  The location is captured by the unit 
immediately, so there is no need to remain still while subsequently editing the 
waypoint name, etc. 

 
b) If you wish to rename the waypoint, select the name field, and press Enter.  Use 

the Rocker Keypad and Enter to select new text, and select “OK” when done. 
 

c) If you wish to change the Waypoint symbol, select the symbol field to the left of 
the Waypoint name and press Enter.  Use the Rocker Keypad and Enter to a 
select new symbol. 

 
d) Once a final name and symbol have been chosen, select the ‘OK’ button to 

permanently save the waypoint. 
 
2.) Average location Waypoint—This feature allows you to average position samples 

over time and save the result as a waypoint.  Averaging reduces the effects of 
position errors and results in a more accurate position reading.  To use the 
averaging function, the Garmin V must be locked onto satellites and have a valid 
position reading.   

 
a) With the Map Page displayed, choose ‘Menu’, then ‘Average Locations’.  

Observe the Accuracy and Measurement Count figures. 
 

 6  



NCBN Information Management Plan Appendix 

b) When these figures reach the desired value(s), highlight Save and press ENTER.  
 

c) The new waypoint appears with a default 3-digit name.  Accept the default, or 
change the name by highlighting the waypoint name field, pressing Enter, and 
choosing a new name with the Rocker Keypad and Enter key.  When finished, 
highlight OK and press Enter.  Then highlight OK on the New Waypoint 
window and press Enter. 

 
3.) Waypoint Notes—You may record up to 50 characters of additional text 

information regarding a waypoint with the Waypoint Note feature.  With the ‘Mark 
Waypoint’ or ‘Waypoint’ page displayed, press the Menu button and select 
‘Waypoint Note’.  Select Edit to bring up the text selection display. 

 
4.) Track logs—Up to 10 line or polygon features can be recorded in the Garmin V 

using Track Logs.  Because of limited memory for each feature, the percent of 
allocated memory used should be regularly monitored on the Tracks Page off of the 
Main Menu.   

 
a) TRACK LOG RECORDING SETUP 

i.) At the Tracks page, press the Menu button and select ‘Setup Track 
Log’.   

ii.) When 100% of the memory for a Track Log has been used, the unit 
will continue saving data by rewriting over the oldest Track Log.  To 
have the unit stop recording when memory is full, check the ‘Wrap 
When Full’ box. 

iii.) Highlight ‘Record Interval’, press Enter, and select the desired 
interval. 

iv.) Highlight ‘Value’ or ‘Resolution’, press Enter, and select the desired 
value or setting. 

v.) When finished, select ‘OK’ and press Enter. 
 

b) SAVE CURRENT TRACK LOG—On the ‘Tracks’ page, select ‘Save’ and 
press the Enter key. 

 
c) DISPLAY ADDITIONAL INFORMATION—On the ‘Tracks’ page, select the 

Track Log in the Saved Tracks window and press Enter. 
 

d) DELETE TRACK LOGS— On the ‘Tracks’ page, select the Track Log in the 
Saved Tracks window and press Enter.  Select ‘Delete’ and Press Enter. 

 
 

VI.   FIELD NAVIGATION 
 
The GPS unit can be used to navigate to known Waypoints and between known 
Waypoints.  Waypoints can be recorded using the GPS unit itself (see Section V), or by 
using the MapSource  software on a PC.  
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1.) Assigning Waypoint Locations—Waypoints can be assigned using the GPS unit 

or MapSource  software. 
 

a) 

b) 

1.) 

2.) 

3.) 

To assign Waypoints in the field using the GPS unit, see Section V,1 above. 
 

To create Waypoints using MapSource , select the Waypoint tool from the 
Tools menu and click in the desired location on the map.  MapSource  will 
prompt for naming and other information.  Upload waypoints to the GPS unit 
using instructions in Section IV, above. 

 
2.) Using the GPS Unit to Navigate in the Field 
 

a) Press the Find button to display the Find Menu, and select Waypoints -> By 
Name.  Enter text to find the desired Waypoint.  Highlight and press Enter. 

 
b) To view the Waypoint on a map, highlight the Map button and press Enter. 

 
c) To navigate to the Waypoint, highlight the GOTO button and press Enter.  Use 

the Rocker Keypad to select routing preferences. 
 

d) To name and save the route that is being navigated, press the Page button until 
the Current Route Page is displayed, press the Menu button, and select Save 
Route. 

 
 

VII.  DOWNLOADING FILES FROM GPS UNIT TO THE PC 
 

Connect the GPS Unit to the Computer:  See Section IV above. 
 

Downloading Data from the GPS Unit Using MapSource: 
 

a.) Open MapSource , select ‘Save to Device’ from the File menu. 
 
b.) Choose the formats of the files to upload (i.e., Waypoints, Tracks, etc.), 

and click Open. 
 

Downloading and Exporting Data from the GPS Unit Using DNRGarmin 
 

a.) Download and install a free copy of DNRGarmin from 
http://www.dnr.state.mn.us/mis/gis/tools/arcview/extensions/DNRGarmin/DNR
Garmin.html 

 
b.) Open DNRGarmin.  Select your desired projection information, if 

prompted.  (UTM in NAD 83 or WGS 84 are standard for many NPS 
protocols.) 
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c.) Click the ‘Data Table’ button. 

 
d.) Choose ‘Download’ under the Waypoint or Track menu, as needed. 

 
e.) To export data in shapefile format, choose File -> Save To… -> File, and 

save as either an unprojected shapefile (remains in lat/long) or projected 
shapefile (data is transformed to your chosen projection/datum). 
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APPENDIX A 
 

BACKPACK ASSEMBLY INSTRUCTIONS FOR GARMIN V SYSTEM  
 

Unpack the re-chargeable battery (P/N 1225-204), connect to the AC/DC adapter, and 
begin charging the battery. Read the IMPORTANT BATTERY INFORMATION at 
the end of this document.  

1) 

2) 

3) 

4) 

5) 

6) 

 
Remove the GIS backpack from the plastic bag. Unzip the backpack and remove the 
black Velcro™ pockets. Remove the multi-colored QuadCom Power/Data Cable, the 
GRAY GPS Antenna Cable and the BLACK MGL-3 Antenna Cable from their bags.  

 
Open the white box containing the MBX-3S differential beacon receiver, the MGL-3 
combination GPS, WAAS, and Radio Beacon antenna, and the vehicle, magnetic, 
antenna mount. At this time, remove the gray, plastic antenna adapter, from the 
magnetic mount, and install it into the MGL-3 antenna. Be very careful not to cross 
thread the antenna, while installing the adapter into the antenna. If you do happen to 
cross thread the antenna, it is still possible to properly install the adapter; it just takes 
more time and careful effort. Also, do not install the gray, plastic, antenna adapter onto 
the backpack pole, before threading it into the MGL-3 antenna, as this also increases 
the risk of cross threading. Then take the remaining magnetic mount base, and store it 
in one of the pockets of the backpack. If necessary, record the serial numbers of the 
MGL-3 and the MBX-3S.  

 
Open the Garmin GPS receiver box and remove the Garmin GPS Map 76. Install 2, AA 
batteries (not supplied in the kit) into the Garmin GPS for back-up power or 
autonomous operation. If necessary, record the unit serial number.  

 
Remove the large Velcro™ pocket from the backpack. Place the MBX-3S receiver into 
the pocket with the receiver connectors on the same end as the two narrow straps and 
the display on the same end as the wide strap. Place the pocket with the MBX-3S into 
the pack. Placement near the top (for ease of viewing) and in the center (to distribute 
the load) seems to work best. The face of the receiver should be pointed toward the top 
of the bag with the top of the receiver toward the person wearing the pack. If you wish 
to have easy access to the front panel display of the MBX-3S, then simply tuck the 
wide Velcro™ strap into the pocket. The cables, which connect to the rear of the MBX-
3S, will prevent it from falling out of the pocket, under normal conditions during field 
use. It is recommended that the large Velcro™ strap be attached over the top of the 
pocket to securely hold the MBX-3S in place during field use.  

 
Take the multicolored QuadCom cable, and place it in the backpack somewhere 
underneath the MBX-3S. Without unwinding the entire cable, make the following 
connections:  

1. Attach the GREEN power cable, with the black, circular 2 pin ConXall power 
connector, to the connector labeled “PWR”, on the MBX-3S  

2. Attach the GREEN XBX data cable, with the GREEN male, DB-9 pin 
connector, to the female 9 pin DB9 serial connector labeled “DATA” on the 
MBX-3S  

Then take the two RF cables and make the following connections:  
3. the GRAY GPS antenna cable to the TNC connector labeled “GPS OUT”  
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4. and the BLACK MGL-3 antenna cable to the BNC connector labeled “ANT 
IN”  

If necessary, refer to the Cabling Diagram attached to these instructions.  
The BLACK antenna cable (TNC connector) should be fed out through the small hole 
on the right topside of the bag and into the antenna sleeve, then out the top of the 
antenna sleeve. The GRAY GPS antenna cable, (MCX connector) and the GRAY 
Data/Power Cable (Garmin 4-pin connector) should be fed out through the small hole 
in the bottom, right-hand side of the bag. You will need about two feet of length in both 
the GRAY cables to comfortably reach around to the front of your body, and about a 
foot of the BLACK antenna cable to reach the MGL-3 antenna. Coil the remaining 
lengths of cables inside the backpack, and use twist ties to hold them neatly in place.  

 
7) 

8) 

9) 

10) 

11) 

Slide the black antenna bar into the left-hand side pocket of the backpack (the side that 
you put the MGL-3 antenna cable out of in step 5). Do not snag or kink the BLACK 
antenna cable. Be sure to place the small Velcro™ strap through the slot in the bar, 
about 12 inches from the top, so that the bar is held tightly in place. If the “L” at the top 
of bar is pointing inward (toward centerline of pack), the antenna will be close to your 
head and less likely to catch on bushes, limbs, etc. when walking in the woods.  

 
Screw the MGL-3 antenna assembly, with the gray plastic adapter, onto the top of the 
antenna bar. Again, make sure the adapter is threaded into the antenna before you 
fasten it to the backpack pole. Wrap the antenna cable around the antenna bar a few 
times so that it will be held closely to the bar, and therefore less likely to catch on 
anything. Attach the BLACK antenna cable (TNC connector) to the MGL-3 antenna.  

 
Attach both the GRAY right-angled MCX RF connector and the GRAY 4-pin data 
power connector to the back of the GPS Receiver. The 4-pin data power connector is 
“keyed”, so be careful to align it properly. Do not force it. Once you have connected 
these cables, find some twist ties or tape to bundle them together, if you do not have a 
piece of split tubing included. It is recommended that you obtain a piece of split tubing 
to bundle the cables together.  

 
Place one of the small, black, Velcro™ battery holders (unfolded) on a flat surface with 
the center felt surface facing down and the small tail strap pointing towards you. Lay 
the external battery (Multiplier label face down and CLP plug on the top left) in the 
center of the holder, flush with the bottom. Fold small tail strap up over the battery so 
that it now points away from you. Fold the right-hand side of the pocket over and then 
the left-hand side so that all attach snugly together, and then attach this inside the 
backpack, near the bottom.  

 
The MBX-3S beacon receiver has no ON/OFF switch. It is turned “ON” or “OFF” by 
connecting or disconnecting it from the power supply. At this time, turn the MBX-3S 
“ON” by plugging the black, male, cigarette lighter adapter plug on the RED Quadcom 
cable, into the female cigarette lighter socket from the battery. The MBX-3S receiver 
display will come on and begin its startup sequence. Once the MBX-3S is powered, it 
will begin searching for the strongest differential signal available. To maximize DGPS 
positional accuracy and repeatability, it is recommended that you manually tune the 
beacon receiver to the closest differential transmitting station, instead of allowing it to 
run in automatic search mode. This is best-done using the Garmin GPS receiver.  
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12) 

13) 

14) 

15) 

Now turn on the Garmin GPS by holding the Power key down for 2 seconds. Once the 
receiver starts up, press the PAGE key twice. Unless you are already outside, or have a 
clear view of the sky, no satellite bars will appear. Please note, that the first time you 
power up the Garmin GPS receiver, with a clear view of the sky, it will take up to 15 
minutes to get its first fix. After the first initialization, the time to first fix will be much 
quicker.  

 
Set up the Garmin GPS. Press the MENU key twice, scroll down to the SETUP 
selection and press ENTER. There are a series of sub-menus, which you can now go 
through and set up according to your preferences. When you get to the LOCATION 
menu, select the hddd° mm’ ss.s location format. The last sub-menu is the 
INTERFACE menu. This is where you set up the Garmin GPS for differential 
operation.  

 
Setting up the Garmin for differential operation (and tuning the MBX-3S). From the 
INTERFACE menu, scroll down to “Serial Data Format” and press “ENTER” Scroll 
down to “RTCM/NMEA”, and press “ENTER” Once this selection is made, the Baud, 
Beacon, Freq., and Bit Rate fields will appear. Set up each one of these appropriately. 
If you have done these correctly, the word “Receiving“ will be displayed in the 
“Status” field. Once lock is achieved on the MBX-3S, the SNR value will appear in the 
“SNR” field. At the same time the word “Differential” will also appear on the satellite 
page to confirm that you have a “Differential GPS” position. Push the QUIT button and 
return to the set of main pages. Press the PAGE button until you see the signal strength 
bar and sky view page. The signal strength bars should have a small “D” in the bottom 
of them if the GPS receiver is receiving a valid differential signal. Your position will 
also be displayed as a “3D Differential” position.  

 
If you do not know what frequency and bit rate to use, you will need to get this 
information. This can be done by accessing the United States Coast Guard web site at: 
www.navcen.uscg.gov/ADO/DgpsSelectStatus.asp or accessing the CSI Wireless web 
site at: www.csiwireless.ca/support/pdfs/radiolistings.pdf. If you do not have web 
access and know the name of the closest beacon station, but do not know the frequency, 
you can use the Beacon Table in the MBX-3S. On the MBX-3S receiver you have three 
functional buttons, an UP arrow, a DOWN arrow and an ENTER button. In order to 
select an option on the receiver, the desired selection must be on the top line of the two 
line display, and then the ENTER button must be pressed to select the option. If an 
undesired selection is made, then scroll up or down to the “BACK” selection, and press 
“ENTER” This will return you to the previous menu level. Once the MBX-3S has 
finished its start-up sequence, you will see “Stn XXX.0 BX00” Press ENTER. Scroll 
down so that "Select Beacon" is on the top line of the display. Press ENTER and scroll 
down until "North America" is on the top line. Press ENTER. Scroll down until 
"U.S.A." is on the top line. Press ENTER. Scroll up or down until you find the name of 
the beacon that is closest to your location and press ENTER to select it. The receiver 
will say "Sending Command...." and will try to lock on to the station. The correct 
frequency and bit rate will be displayed for a few seconds while it tries to tune. Make 
note of these numbers and then re-tune to that frequency using the Garmin GPS as per 
Step 14 above.  

 
Note: The Signal to Noise Ratio (SNR) value must be higher than 6 for the receiver to lock. 
When it locks on to a station, the lock symbol in the top right corner of the display of the MBX-
3S will close. If it does not immediately lock on to the station, there can be several reasons; if 
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you are inside, the type of building material can prevent lock, if you are outside, power lines or 
other sources of RF interference can be present. If you are in a vehicle, try to locate the MGL-3 
antenna away from the engine. Moving the antenna just a few inches can make a difference. If 
after being in differential mode, the MBX-3S loses lock status, the Garmin GPS will continue 
to operate in “Differential” mode for 30 seconds, after which time an error message will appear, 
letting the user know that differential is no longer available.  

 
 
 
 

**IMPORTANT BATTERY INFORMATION**  
**PLEASE READ UPON RECEIPT OF SYSTEM**  

 
M5010 Rechargeable Battery Information  

 
1) All batteries will ship from 3-D Marketing pre-charged 80-90%  
2) Battery must be recharged at least once every 6 months when not in use and must be 

stored at ambient temperature (25 °C)  
3) 100% drainage per usage will yield approximately 200 recharging cycles; 50% 

drainage per usage will yield approximately 400 recharging cycles; 30% drainage 
per usage will yield approximately 1000 recharging cycles.  

4) Using 3-D’s AC/DC Adapter (output 12VDC @ 500mA), it will require 8 full hours 
to completely recharge a drained battery. It will require 4 hours to completely 
recharge a 50% drained battery and so on.  

5) When charging is complete, disconnect the charger from both the battery and the 
AC power. Leaving the battery attached to the charger after charging is complete, 
must result in a minor battery drain.  
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APPENDIX B 
 
Beacon Interface Setup 
 
Setup - Interface - Serial Data Format - "RTCM in/ NMEA out" (Note: if you want to 
connect the GPS to a computer you will have to change this to “GARMIN” but don’t 
forget to change it back when using the dGPS.) 

- Baud - "4800" 
- Frequency - "306.0" (Acushnet) ---- enter your closest beacon  
- frequency here 
- Bit Rate - "200" (for Acushnet 's) ----- enter the value that your beacon is set 

at 
- Status - should say "receiving"; otherwise "no signal"; "check wiring" means the 

battery is dead or not hooked up correctly 
- SNR - signal to noise ratio - the higher the #, the better; choose the closest 

beacon that has the highest SNR 
 
FUSES: if the unit shuts down for no apparent reason, check the fuses on the cigarette 
lighter connectors.  Replace blown fuses with 3A/250v fuses from radio shack. 
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